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JLAB ACCOUNT: WHAT DO YOU GET ACCESS TO?
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● JLab Web Portal
● Office 365 / Only Outlook(staff or intern only)
● Virtual Private Network (VPN)
● GitLab
● JupyterHub
● Virtual Desktop Infrastructure (VDI)
● ifarm
● slurm



WHAT SETUP IS REQUIRED OTHER THAN JLAB ACCOUNT?
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misportal.jlab.org/portal/insight

o Items marked with * also require approval from your Group/Hall 
Computing Coordinator:
o https://jlab.servicenowservices.com/kb?id=kb_article_view

&sysparm_article=KB0014686

o No MFA (Multifactor Auth):
1. JLAB Web Portal
2. GitLab

o Microsoft Authenticator Setup
1. Office 365/Outlook
2. JupyterHub*

o MobilePass Phone App/USB Code Generator
o VPN
o VDI
o ifarm*
o slurm*

• For more details, refer to “Acquiring a JLab Account Presentation”:
https://indico.jlab.org/event/1069/attachments/13992/22649/acquiring_jlab_account.pdf

https://misportal.jlab.org/portal/insight/frontPage
https://jlab.servicenowservices.com/kb?id=kb_article_view&sysparm_article=KB0014686
https://jlab.servicenowservices.com/kb?id=kb_article_view&sysparm_article=KB0014686
https://jlab.servicenowservices.com/kb?id=kb_article_view&sysparm_article=KB0014686
https://indico.jlab.org/event/1069/attachments/13992/22649/acquiring_jlab_account.pdf


JLAB WEB PORTAL
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o Accessing this web portal gives you access to:
o Training (https://misportal.jlab.org/training/people/srl)
o JList (staff directory)
o Help-desk, library, and facilities tickets (https://jlab.servicenowservices.com)
o Requisition system, etc.

https://misportal.jlab.org/training/people/srl

misportal.jlab.org/portal/insight

https://misportal.jlab.org/training/people/srl
https://jlab.servicenowservices.com/nav_to.do?uri=%2Fhome.do%3F
https://misportal.jlab.org/training/people/srl
https://misportal.jlab.org/portal/insight/frontPage
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o Ask your sponsor or support staff at the lab for guidance
o Email helpdesk@jlab.org for computing assistance
o Email library@jlab.org for journal/book access questions
o Use the servicenow portal for facilities and other tickets

https://jlab.servicenowservices.com

JLAB WEB PORTAL

mailto:helpdesk@jlab.org
mailto:library@jlab.org
https://jlab.servicenowservices.com/nav_to.do?uri=%2Fhome.do%3F


OFFICE 365/ OUTLOOK (ONLY FOR STAFF OR INTERNS)
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o Microsoft Authenticator (MFA) setup is required for 
access to Microsoft Office 365 

o There are two types of Office 365 access, that can be 
assigned by your supervisor or account requester: 
o Full Office 365 access:

o Access to all Office apps (Teams, Outlook, 
PowerPoint, etc.)

o Verify at: www.office.com 
o Email-only access:

o Outlook access only
o Verify at: outlook.office365.com

Full Office 365 access

http://www.office.com/
https://outlook.cloud.microsoft/mail/


VIRTUAL PRIVATE NETWORK (VPN)
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o Provides offsite access to JLab resources as if you 
are on the internal network 

o Enables access to internal-only systems (e.g., 
Insight protected pages)

o How to connect:
o Web interface: http://vpn.jlab.org/
o Desktop client (setup support available via 

Helpdesk) 
o Authentication required:

o MobilePASS app or USB code generator 
o Login format: 6-digit PIN + generated code 

http://vpn.jlab.org/

Desktop Client

http://vpn.jlab.org/
http://vpn.jlab.org/


GITLAB (CODE.JLAB.ORG)
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o JLab’s hosted Git platform for version control and 
collaboration
o https://code.jlab.org 
o Used for managing and sharing code 

repositories across projects
o Login with CUE username & password (no MFA 

required for web access)
o Supports:

o Repository sharing and collaboration
o CI/CD pipelines
o Storage for containers, models, and artifacts

o Hands-on session (later slides):
o Basic Git workflows (clone, commit, push) will 

be covered.
o For advanced features & documentation:

https://pages.jlab.org/scicomp/software/code
-gitlab-docs/ 

https://code.jlab.org/
https://code.jlab.org/
https://pages.jlab.org/scicomp/software/code-gitlab-docs/
https://pages.jlab.org/scicomp/software/code-gitlab-docs/
https://pages.jlab.org/scicomp/software/code-gitlab-docs/
https://pages.jlab.org/scicomp/software/code-gitlab-docs/
https://pages.jlab.org/scicomp/software/code-gitlab-docs/


JUPYTERHUB
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o https://jupyterhub.jlab.org - JLab’s hosted Python 
notebook environment

o Provides access to GPUs and JLab file systems
o Supports interactive development, data analysis, and 

visualization workflows
o Authentication:

o Requires MFA via Microsoft Authenticator
o MFA setup occurs during first login

o Contact Help Desk for setup assistance
o Getting Started Guide:

o https://scicomp.jlab.org/docs/JupyterHub 

CUE Username & password Microsoft Authenticator code

https://jupyterhub.jlab.org/
https://jupyterhub.jlab.org/
https://scicomp.jlab.org/docs/JupyterHub
https://scicomp.jlab.org/docs/JupyterHub


VIRTUAL DESKTOP INFRASTRUCTURE (VDI)
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o VDI accessed via VMware Horizon, provides a remote virtual machine linked to your JLab CUE account
o Provides a RHEL9 Linux desktop with access to shared resources
o Requires RHEL9 access request via Help Desk
o Two Options: VMware client (desktop) or Web browser (no setup). Both options will be shown on vdi.jlab.org

https://vdi.jlab.org Select RHEL9 machine (Windows 
requires SmartCard!!)​

Enter CUE Username​
(Password = MobilePASS SAS MFA PIN+Code ​)

Log in with CUE Username and Password​

1.
2.

4.

3.

Web access

https://vdi.jlab.org/


JLAB FILESYSTEMS
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Manual vs Auto: /home and /work require manual deletion when full (hard limits), while /cache and /volatile always allow 
writes but are automatically cleaned up when over quota (soft limits).

Path Best Use FS Type Deletion backup

/cache Bulk I/O, Tape system interaction Lustre Once on tape /mss

/volatile Bulk I/O Temporary storage Lustre auto NO

/work Source code, DB files, exe’s, etc.
User Managed

NFS+ ZFS manual NO

/home Dot files, personal documents, etc NFS ssd manual YES

/farm_out Farm job stdout/stderr NFS ssd auto NO

/group or /scigroup Source code
Papers, thesis, analysis scripts

NFS ssd Manual YES

/scratch/$SLURM_JOB_ID Farm job I/O to node local disk ssd auto NO

/u/scratch CUE scratch. Deprecated (Unavailable on el9)

/cvmfs Software stack, Configuration. 



JLAB FILESYSTEMS – DISK USAGE
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o Web interface for checking used and available quota for JLab filesystems:
o https://scicomp.jlab.org/scicomp/workDisk

o Hands-on Session (later slides): 
o How to check disk usage status on ifarm

o Overall filesystem usage
o User-specific usage

o Focus: debugging “quota exceeded” issues

https://scicomp.jlab.org/scicomp/workDisk
https://scicomp.jlab.org/scicomp/workDisk


JLAB FILESYSTEMS – HOW TO ACCESS
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o The following systems provide access to the same shared filesystems
/home/<username>, /work, /group, /cache, /volatile

o VDI
o JupyterHub
o ifarm  - recommended access method
o slurm

o Same files, same data, regardless of where you access them
o Work in one system, access it from another
o Important: 

o Compute resources does differ across systems, .e.g.
o ifarm nodes: ~256 physical threads per node
o VDI (RHEL): ~2 physical threads
o Systems share storage, but not compute power

• VDI & JupyterHub: already covered, VDI will 
be revisited briefly in hands-on

• ifarm: next slide (also main hands-on focus)
• slurm: May 14 session



JLAB IFARM
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JLab's shared HPC:
• Computing cluster "farm"
• Has interactive capability through "ifarm"
• Two nodes (ifarm2401, ifarm2402)
• Provides access points for testing, etc. 

before sending off to production farm
• Interactive nodes:

• AMD EPYC 9554 (Zen 4 "Genoa") 
• 256 threads (2 sockets × 64 cores × 

2 threads/core) 
• 3.1 GHz base / 3.76 GHz max 
• 1.5 TB memory 

Source: https://scicomp.jlab.org/docs/getting_started 

https://scicomp.jlab.org/docs/getting_started


JLAB IFARM
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o These nodes are shared among multiple 
users 

o They are powerful but intended for: 
o Short interactive computation 
o Code testing and development 
o Job submission preparation 

o Heavy or long-running workloads should 
be executed on worker nodes via slurm 

Source: https://scicomp.jlab.org/docs/getting_started 

https://scicomp.jlab.org/docs/getting_started


JLAB IFARM - ACCESSING VIA VSCODE (REMOTE SSH)
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o One of the easiest ways to access ifarm is using the 
Remote SSH extension in VS Code

o We will go through the full setup in the hands-on session

Why VS Code Remote SSH?
o It provides strong flexibility for remote development

o Work on remote servers as if they are local
o Open files, terminals, run code, and debug 

seamlessly
o Run and manage multiple terminals/folders without 

repeatedly reconnecting
o Same editor experience across local and remote 

environments
o Previously opened folders are saved for quick access
o Multiple hosts can be configured in ~/.ssh/config

o Connect directly without remembering proxy 
jumps or complex SSH commands



JLAB IFARM - ACCESSING VIA VSCODE (REMOTE SSH)
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Source: https://code.visualstudio.com/docs/remote/ssh 

SSH is like a secure, encrypted tunnel over the internet (TCP) that lets you work on a remote computer as if it 
were right in front of you.

Remote SSH Extension uses SSH to connect securely to a remote machine and starts a small VS Code server 
there. That VS Code server mainly does all the work—opening files, running code, and handling commands. Your 
VS Code on your laptop just conveys whatever actions you are taking to this server over SSH and shows you the 
output of your actions. Everything happens so fast that it feels like you are working directly on the remote 
machine.

https://code.visualstudio.com/docs/remote/ssh


HANDS-ON SESSION
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OUTLINE
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1. VS Code Setup & Basics
• Install VS Code, open folders, use terminal.

2. Remote SSH to ifarm
3. Check Filesystems Disk Capacity & Usage
4. Port Forwarding

• Access remote network apps locally via forwarded ports.
5. X11 Forwarding

• Access GUI apps running on ifarm from local machine.
6. GitLab First Commit & Push



SECTION 1: VSCODE SETUP & BASICS
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INSTALLING VSCODE
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o Go to https://code.visualstudio.com/download and download the installer that matches your operating system.

Click one of these 
with download 
icon based on 
your OS

Section 1: VS Code Setup & Basics

https://code.visualstudio.com/download


VSCODE – OPENING YOUR FIRST FOLDER
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o Once the download is complete, click the downloaded file and follow the installation instructions.
o After installation, launch VS Code by searching it in your operating system’s search bar.

Section 1: VS Code Setup & Basics



VSCODE – OPENING YOUR FIRST FOLDER
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o Once VS Code is open, go to File > Open Folder… from the menu.
o Create a new folder named vscode101, select it, and it will open inside VS Code.

Section 1: VS Code Setup & Basics



VSCODE – OPENING YOUR FIRST FOLDER
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o Once VS Code is open, go to File > Open Folder… from the menu.
o Create a new folder named vscode101, select it, and it will open inside VS Code.

Section 1: VS Code Setup & Basics



VSCODE – OPENING YOUR FIRST FOLDER
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o Once VS Code is open, go to File > Open Folder… from the menu.
o Create a new folder named vscode101, select it, and it will open inside VS Code.

Section 1: VS Code Setup & Basics



VSCODE – OPENING YOUR FIRST FOLDER
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o Once VS Code is open, go to File > Open Folder from the menu.
o Create a new folder named vscode101, select it, and it will open inside VS Code.

Section 1: VS Code Setup & Basics



VSCODE – EXPLORER VIEW
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o You should now see the Explorer view on the left, showing the name of the folder.
o You'll use the Explorer view to view and manage the files and folders in your workspace.

27

Section 1: VS Code Setup & Basics



VSCODE – ACTIVITY BAR
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o Use the Activity Bar to switch between different views.
o Tip: Hover over the Activity Bar to see the name of each view and the corresponding keyboard shortcut. You can 

toggle a view open and closed by selecting the view again or pressing the keyboard shortcut.

Section 1: VS Code Setup & Basics



VSCODE – ACTIVITY BAR
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o When you select a view in the Activity Bar, the Primary Side Bar opens to show view-specific information.

29

Section 1: VS Code Setup & Basics



VSCODE – VIEW AND EDIT FILES
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Select the Explorer view in the Activity Bar, and select the New File button to create a new file in your workspace.

Section 1: VS Code Setup & Basics



VSCODE – VIEW AND EDIT FILES

31

o Enter the name index.html and press Enter. A file will be added to your workspace and an Editor will open in the main 
area of the window.

Section 1: VS Code Setup & Basics



VSCODE – VIEW AND EDIT FILES
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o Start typing some HTML code in the index.html file.

Section 1: VS Code Setup & Basics



VSCODE – VIEW AND EDIT FILES
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o Add more files to your workspace and notice that each file opens a new Editor tab.
o You can open as many editors as you like and view them side by side vertically or horizontally. 

o Learn more about side by side editing.

Section 1: VS Code Setup & Basics

https://code.visualstudio.com/docs/getstarted/userinterface#_side-by-side-editing


VSCODE – OPEN TERMINAL
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o VS Code has an integrated terminal.
o Open it by pressing ⌃`.
o You can also use the View > Terminal menu 

item.

34



VSCODE – RUN A COMMAND IN TERMINAL
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o In the terminal, enter the following command to create a new file in your workspace.
o echo "Hello, VS Code" > greetings.txt

o The default working folder is the root of your workspace. Notice that the Explorer view automatically picks up and 
shows the new file

35

Section 1: VS Code Setup & Basics



VSCODE – MULTIPLE TERMINALS
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o You can open multiple terminals simultaneously. Select the Launch Profile dropdown to view the available shells and 
choose one.

Section 1: VS Code Setup & Basics



VSCODE – KEYBOARD SHORTCUTS
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o You can view all VS Code keyboard shortcuts for your operating system by going to the Help menu (top-
left corner) and selecting “Keyboard Shortcuts Reference.”
o This will open a webpage with a complete shortcut cheat sheet tailored to your OS.

o The next slide also highlight some of the most useful shortcuts to get you started.

37

Section 1: VS Code Setup & Basics



VSCODE – KEYBOARD SHORTCUTS
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Prefix: Cmd (Mac) / Ctrl (Windows/Linux)

Editing 
Select text → <prefix> + D
o Select next matching word (multi-cursor editing)
Select text → <prefix> + Shift + L
o Select ALL matching words in file
<prefix> + / → Comment / uncomment a line or selection
<Alt + ↑ / ↓> (Mac: Option + ↑ / ↓) → Move line up or 
down
<Shift + Alt + ↑ / ↓> → Copy line up or down

File & Code Productivity
<prefix> + S → Save file
<prefix> + N → New file
<prefix> + W → Close tab/file
<prefix> + Z → Undo
<prefix> + Shift + Z → Redo

Search & Navigation
<prefix> + P → Quick Open (search files in project)
<prefix> + Shift + F → Search across entire project 
(workspace)
<prefix> + F → Search inside current file

UI / Panels
<prefix> + B → Toggle sidebar (file explorer)
<prefix> + J → Toggle bottom panel (terminal)

Section 1: VS Code Setup & Basics



SECTION 2: REMOTE SSH TO IFARM
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VSCODE – REMOTE SSH TO IFARM
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o For SSH access to ifarm using VSCode, we just need these two:
o VSCode - already downloaded & installed (previous slides).
o  Remote-SSH extensions - upcoming slides.

Section 2: Remote SSH to ifarm



VSCODE - INSTALLING REMOTE SSH EXTENSIONS

o Go to Activity Bar and switch to extensions panel and install Remote-SSH extension (search remote)

Extensions

Click here
41

Section 2: Remote SSH to ifarm



VSCODE - INSTALLING REMOTE SSH EXTENSIONS
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o Installing “Remote – SSH” extension also installs:
o Remote Explorer
o Remote - SSH: Editing Configuration Files

o Only install Remote – SSH (others come automatically)
o Remote – SSH (Core)

o Connect to remote machines via SSH
o Work as if VS Code runs on the remote system
o Open files, run terminal, debug
o Engine for remote development

o Remote Explorer (UI)
o View saved hosts & environments
o One-click connect
o Dashboard/sidebar

o Remote - SSH: Editing Configuration Files
o Edit ~/.ssh/config in VS Code
o Add hosts, users, ProxyJump
o Configuration tool All three extensions show no 

download icon, showing 
they’re automatically installed 
with Remote - SSH.

Download icon

Section 2: Remote SSH to ifarm



VSCODE – SETTING UP SSH CONFIG FILE

o Go to Remote Explorer panel using Activity Bar and click on settings icon. Now hit enter selecting ~/.ssh/config 
file

43

Section 2: Remote SSH to ifarm



VSCODE – SETTING UP SSH CONFIG FILE
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o This will open an empty ~/.ssh/config file to edit:

Section 2: Remote SSH to ifarm



VSCODE – SETTING UP SSH CONFIG FILE
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o Paste the exact content into the config file, then press Ctrl/Cmd + S to save. Make sure the 
indentation (tabs and spacing) is correct.

Host login.jlab.org
    HostName login.jlab.org
    User <your_jlab_username>

Host ifarm
    HostName ifarm
    User <your_jlab_username>
    ProxyJump login.jlab.org
    RequestTTY force
    ForwardX11 yes
    ForwardX11Trusted yes

o You will start seeing host names in the Remote 
Explorer Panel

Note: Replace <your_jlab_username> with your actual 
JLab username in the file.

Section 2: Remote SSH to ifarm



VSCODE – SSH CONFIG FILE EXPLANATION
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o login.jlab.org 
o Host login.jlab.org 

o Defines a connection named login.jlab.org

o HostName: actual server address
o User: username used to log in (rasool)

o ifarm
o Host ifarm

o Defines a connection named ifarm

o HostName: actual server address
o User: username used to log in (rasool)
o ProxyJump login.jlab.org: 

o connects via login server first (jump host)
o RequestTTY force: forces interactive terminal session
o ForwardX11 yes / ForwardX11Trusted yes

→ Required for X11 forwarding (later slides)

This defines the display name shown in the Remote Explorer 
panel for this connection—you can name it anything you prefer.

Section 2: Remote SSH to ifarm



VSCODE - CONNECT TO IFARM

47

o Go to Remote Explorer and click on open in new window icon:

Section 2: Remote SSH to ifarm



VSCODE - CONNECT TO IFARM
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o A new window will open with a password prompt. 
o Enter your 6-digit PIN + MobilePass/USB token. 
o You are logging into login.jlab.org, which acts as the gateway to access ifarm. 

o The ProxyJump login.jlab.org setting in the config automatically handles this intermediate step.

Section 2: Remote SSH to ifarm



VSCODE - CONNECT TO IFARM
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o After entering your password for login.jlab.org, a second prompt will appear for @ifarm. Enter your CUE (JLab) account 
password to complete the login.

o For any additional pop-ups, simply select the default trusted option such as “Linux” or “Continue”, depending on what 
is shown.

Section 2: Remote SSH to ifarm



VSCODE - CONNECT TO IFARM
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o After completing all the prompts, you will be successfully connected to ifarm. You should now see “SSH: ifarm” 
displayed in the bottom-left corner of VS Code, confirming the connection is active.

50

Section 2: Remote SSH to ifarm



VSCODE – OPEN A FOLDER ON IFARM
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o To open a folder on ifarm, go to the Explorer panel in the Activity Bar and click “Open Folder”.
o A prompt will appear at the top where you can enter a directory path to navigate to. 
o For now, simply hit Enter to use the default path, which is your user directory (/home/<username>).

51

Section 2: Remote SSH to ifarm



VSCODE – OPEN A FOLDER ON IFARM
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o After connecting to a folder once on a host that path get saved and next time you can directly connect to host on that 
path by just clicking on that path

Open remote folder in current window Open remote folder in new window
52

Section 2: Remote SSH to ifarm



SECTION 3: FILESYSTEMS DISK CAPACITY
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IFARM – CHECKING FILESYSTEMS DISK CAPACITY

o In Slide 11 (“JLAB Filesystems”), we discussed that /home and /work have hard storage limits. If the total 
capacity is reached, you will encounter a “disk quota exceeded” error.

o Now, let’s look at some useful commands to check disk usage:
o df -h → Displays disk usage for all filesystems on the system

o Focus mainly on /w (/work) and /home, as these are most relevant for you

-h (human-readable) 
displays storage in KB, 
MB, GB, etc., instead of 
raw bytes

54

Section 3: Filesystems Disk Capacity



IFARM – CHECKING FILESYSTEMS DISK CAPACITY

o df -h . → Shows filesystem details for the current directory
o df -h <path_to_directory> → Shows filesystem details for the given directory
o If you encounter a quota error, navigate to the affected directory and run:

o df -h . or df -h <path_to_directory>

Note: df shows overall disk usage and capacity for entire filesystem(s) (across all users)

55

Section 3: Filesystems Disk Capacity



IFARM – CHECKING FILESYSTEMS DISK CAPACITY

o Since you cannot delete other users’ files, the quickest way to resolve a disk quota issue is to check your 
own disk usage and remove unnecessary files.

o To see how much space your files are using within a directory, run:
o du -h --max-depth=1 → size of current directory + immediate subfolders

o -h → human-readable sizes (KB, MB, GB)
o du -ah –max-depth=1 → includes individual files as well

o -a → includes all files (not just directories)

Note: --max-depth=1 limits the output to one level of subdirectories, avoiding deeply nested listings

56

Section 3: Filesystems Disk Capacity



IFARM – FILESYSTEMS DISK CAPACITY & VSCODE

o As mentioned in Slide 17 (“VS Code Remote SSH”), VS Code installs a VS Code Server on the remote 
machine before connecting.
o By default, it is downloaded to your home directory: /u/home/<username>

o If the /home filesystem is full → the server cannot download → connection fails

o How to Avoid
o Store any large or space-taking files in the /w(/work) directory instead of /home to prevent the home 

filesystem from filling up
o If you frequently face this issue, you can redirect VS Code to install the server in /work (/w) instead of 

the default /home directory:
o https://stackoverflow.com/questions/62613523/how-to-change-vscode-server-directory
o In most cases, using your allocated /work directory for project work significantly reduces the 

chances of running into storage quota issues

57

Section 3: Filesystems Disk Capacity

https://stackoverflow.com/questions/62613523/how-to-change-vscode-server-directory
https://stackoverflow.com/questions/62613523/how-to-change-vscode-server-directory
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https://stackoverflow.com/questions/62613523/how-to-change-vscode-server-directory


IFARM – FILESYSTEMS DISK CAPACITY & VSCODE

o As mentioned in Slide 17 (“VS Code Remote SSH”), VS Code installs a VS Code Server on the remote 
machine before connecting.
o By default, it is downloaded to your home directory: /u/home/<username>

o If the /home filesystem is full → the server cannot download → connection fails

o How to Fix
o Free up space in /home

o Login to VDI (since VS Code won’t connect and VDI has access to the same filesystem)
o Open terminal in your home directory and check capacity & usage: 

o df -h .
o du -ah --max-depth=1 

o Delete unnecessary files: 
o rm -rf ./.cache 
o rm -rf ./.vscode-server 

58

Section 3: Filesystems Disk Capacity



IFARM – FILESYSTEMS DISK CAPACITY & VSCODE

o Login to VDI

59

https://vdi.jlab.org Select RHEL9 machine (Windows 
requires SmartCard!!)​

Enter CUE Username​
(Password = MobilePASS SAS MFA PIN+Code ​)

Log in with CUE Username and Password​

1.
2.

4.

3.

Web access

Section 3: Filesystems Disk Capacity

https://vdi.jlab.org/


IFARM – FILESYSTEMS DISK CAPACITY & VSCODE

o Open terminal:

Click activities 
button

1.

Click Terminal Icon
2.

60

Section 3: Filesystems Disk Capacity



IFARM – FILESYSTEMS DISK CAPACITY & VSCODE

o Check usage:

o Now delete as required using the remove command:

o Once you see sufficient free space using df -h ., you can retry connecting through VS Code and it should 
work.
o In most cases, deleting ./.vscode-server and ./.cache is enough to resolve the issue.

61

Section 3: Filesystems Disk Capacity



SECTION 4: PORT FORWARDING

62



PORT FORWARDING

o Port Forwarding 
o What is this?

o Remote server runs an app on a specific port (e.g., 3000)
o This port is not directly accessible from your laptop
o Port forwarding creates a secure tunnel
o localhost:3000 → connects to remote port 3000

o Makes the remote app behave like it’s running locally
o Without it, you can’t access remote services in your browser

63

Section 4: Port Forwarding



PORT FORWARDING

o Port Forwarding in Visual Studio Code
o Automatically detects running ports (e.g., 3000, 8000)
o Forwards them with no manual setup
o Open via:

o Browser by entering localhost URL
o Or Ctrl/Cmd + click the link on terminal

o Without VS Code
o Manual setup required for each port:

o ssh -L 3000:localhost:3000 -J <username>@login.jlab.org <username>@ifarm.jlab.org
o -L forwards a local port to a remote service – Port Forwarding
o -J uses an intermediate jump host (ProxyJump) to reach the target server.

o Need to repeat for every new port

64

Section 4: Port Forwarding



RUNNING NETWORK BASED APPS ON IFARM

 Port Already in Use Error
o When running network-based applications on ifarm that require a fixed port, you may encounter a 

“Port Already in Use” error
o It’s because ifarm is a shared system and ports may already be used by other users
o If a port is occupied, your app cannot start because it cannot bind to the required port
o Solution: You must switch to an available (unused) port in that case. 

o Check used ports:
o netstat -tulp → lists all active ports
o netstat -tulp | grep 6062 → check a specific port
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o In upcoming example, the setup 
automatically selects an available 
port and Visual Studio Code 
forwards it.
o So you likely won’t face this 

issue in the demo
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VSCODE – PORT FORWARDING (EXAMPLE)

o After SSH’ing into ifarm open terminal (Ctrl/Cmd + `):
o Clone a simple app that visualizes static data:

o git clone https://code.jlab.org/rasool/sales-viz.git

o Move into the cloned directory:
o cd sales-viz

o Install all required dependencies before running the app:
o npm install

o Run the application:
o npm run dev1.

2.

3.

4.

Hover over link to see this message

Local Browser
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VSCODE – PORT FORWARDING

o You can also open the Ports panel in VS Code to view all currently running application ports and see where 
they are being forwarded. With the previous app running, the Ports panel looks like this.

You can also use Cmd/Ctrl + 
click here to open the port 

directly.

o To stop the running application, press Ctrl + C in the terminal.
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SECTION 5: X11 FORWARDING

68



X11 FORWARDING

o X11 Forwarding (GUI over SSH)
o Allows running GUI apps on a remote server and displaying them locally
o Unlike port forwarding (network apps), X11 is for graphical applications
o Example

o Run apps like xclock, ROOT on ifarm
o GUI window appears on your local machine

o Requirements
o Local system needs an X server

o macOS → XQuartz (https://www.xquartz.org/)
o Windows → VcXsrv (https://sourceforge.net/projects/vcxsrv/)
o Linux → built-in support
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X11 FORWARDING – USING VDI

o Easier Option — VDI
o Use VDI for GUI applications
o Already supports graphical display (no setup needed)
o Shares the same filesystem with ifarm

o When to use
o Works if the app does not require ifarm-specific compute resources or environment
o If heavy computation or ifarm-only setup is needed:

o use ifarm with X11 forwarding instead (next slides)

o How it works
o Log in to VDI
o Run GUI apps directly from the terminal
o No X11 forwarding or X server required
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X11 FORWARDING – USING VDI

o Login to VDI

https://vdi.jlab.org Select RHEL9 machine (Windows 
requires SmartCard!!)​

Enter CUE Username​
(Password = MobilePASS SAS MFA PIN+Code ​)

Log in with CUE Username and Password​

1.
2.

4.

3.

Web access
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X11 FORWARDING – USING VDI

o Open the terminal

Click activities 
button

1.

Click Terminal Icon
2.
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X11 FORWARDING – USING VDI

o Run the GUI app
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X11 FORWARDING – BY SSH’ING TO IFARM

o As during SSH config setup for ifarm, we already added 
following to ~/ssh/config file:
o ForwardX11 yes  
o ForwardX11Trusted yes

o Now, you only need to install an X server on your local 
machine based on your OS:
o macOS → XQuartz 

o (https://www.xquartz.org/)
o Windows → VcXsrv

o (https://sourceforge.net/projects/vcxsrv/)
o Linux → Built-in support 

o (no additional setup needed)
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X11 FORWARDING – BY SSH’ING TO IFARM

o Once X server is installed:
o SSH into ifarm using VS Code as before. 
o Open the VS Code terminal and run any GUI 

application
o The X server will:

o Start automatically
o Display the remote app’s GUI on your local 

machine.
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X11 FORWARDING – BY SSH’ING TO IFARM

 Offsite GUI Slowness (ifarm)
o If you run a GUI app on ifarm while offsite, it 

may become very slow 
o This happens because the X Server is running 

on your local machine, outside the JLab 
network 

o As a result, GUI rendering and interactions 
can lag significantly 

o Fix:
o Log into the VDI 
o Open a terminal inside VDI 
o SSH into ifarm from there and run your 

application 
This way, the X Server runs inside the JLab 
network, making GUI performance much 
smoother
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X11 FORWARDING – BY SSH’ING TO IFARM

 Offsite GUI Slowness (ifarm)
o Fix:

o SSH command:
o ssh -Y -J <username>@login.jlab.org <username>@ifarm.jlab.org

o -Y = X11 forwarding with encryption
o -J = ProxyJump

o In most cases performance is fine, but if you experience slowness, this is the recommended workaround
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Run the app

SSH to ifarm Enter PIN + USB/MobilePass Token

Enter JLab Account Password
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SECTION 6: GITLAB FIRST COMMIT & PUSH
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GITLAB - (CODE.JLAB.ORG)

o What is Git?
o A version control system that tracks changes in your code over time
o Think of it as a save history for your project

o Why use Git?
o Go back to previous versions if something breaks
o See what changed and when
o Work on new features without affecting the main code

o Collaboration
o Multiple people can work on the same project
o Changes can be combined safely

o In short: Git helps you manage, track, and safely update your code
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GITLAB - (CODE.JLAB.ORG)

GitLab
o A web-based platform built on top of Git for collaboration and project management 
o Makes working with Git repositories easier through a visual interface 
o Adds team-level tools beyond version control
o On top of Git, it enables:

o Remote repositories (cloud-based code storage) 
o Collaboration via merge requests (code reviews) 
o Issue tracking (bugs, tasks, features) 
o CI/CD pipelines (automated testing & deployment) 
o Project wikis and documentation
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In short: Git handles version control. GitLab turns it into a 
collaborative development platform.
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GITLAB – CREATING A NEW REPO

o Log in to the GitLab instance deployed at code.jlab.org using your JLab or federated account 
credentials.
o Use your JLab CUE account if you have one for creating repo

https://code.jlab.org/ 81

Section 6: GitLab First Commit & 

Push

https://code.jlab.org/


GITLAB – CREATING A NEW REPO

o Log in to the GitLab instance deployed at code.jlab.org using your JLab account credentials.

https://code.jlab.org/ 
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GITLAB – CREATING A NEW REPO

o Log in to the GitLab instance deployed at code.jlab.org using your JLab account credentials.

https://code.jlab.org/ 83
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GITLAB – CREATING A NEW REPO

o Log in to the GitLab instance deployed at code.jlab.org using your JLab account credentials.

https://code.jlab.org/ 
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GITLAB – CREATING A NEW REPO

o Once logged in, you’ll see the list of projects under JLAB. Click the “New Project” (repository) 
button in the top-right corner.
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GITLAB – CREATING A NEW REPO

o Select “Create blank project.” Other options can also be used, but for simplicity, start with a blank project.
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GITLAB – CREATING A NEW REPO

o Now fill in all the required details to create the GitLab project as shown below.

1. Add Project Name

2. Choose a namespace:
o For now, select your own 

username. 
o For future work, choose the 

group associated with your 
project if any available.
o You can also create 

groups

3. Uncheck “Initialize 
repository with a README”
We will add the README in our 
first commit, so it’s not needed 
at setup.

4. Create Project
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GITLAB – CREATING A NEW REPO

o You should now land on a page that provides all the details needed to connect your local repository to this 
remote GitLab repository.

1. We will set the configuration globally so you don’t have to 
repeat it for every repository. Switch to the Global tab.

2. We will use HTTPS to push changes after committing, so switch to the HTTPS tab.

3. We are creating a new repository so 
we will follow these instructions
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GITLAB – YOUR FIRST COMMIT

SSH into ifarm, open the terminal, and run the commands provided by GitLab:

o Clone the repository
o git clone https://code.jlab.org/rasool/git101.git

o Move into the project directory
o cd git101

o Create and switch to a new branch
o git switch --create main

o Create a README file
o touch README.md

o Stage the changes
o git add README.md

o Set global Git identity (required for commits)
o git config --global user.name "Rasool, Raiqa”
o git config --global user.email rasool@jlab.org

o Make your first commit
o git commit -m "add README"
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GITLAB – PUSHING FIRST COMMIT

o Before doing your first push, you need to set up a Personal Access Token (PAT) and enable credential 
storage so you don’t have to re-enter your login details every time.

o Generate a Personal Access Token
1. Click your profile avatar in the top-right corner, then select Preferences.
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GITLAB – PUSHING FIRST COMMIT

o Before doing your first push, you need to set up a Personal Access Token (PAT) and enable credential storage 
so you don’t have to re-enter your login details every time.

o Generate a Personal Access Token
 2. Go to “Access” and select “Personal access tokens.”
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GITLAB – PUSHING FIRST COMMIT

o Generate a Personal Access Token
 3. Enter all required details and hit “Generate token” button:

1. Give Token a name
• This will show as this token’s name in access tokens list

2. Set expiration date
• Recommended: ~6 months (more secure, requires renewal).
• Alternatively: set to max (usually 1 year) to avoid frequent re-

setup.

3. Set token permissions
• Preferably, choose only the 

permissions you need. 
• For simplicity in this setup, 

check all

4. Generate Token 92
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GITLAB – PUSHING FIRST COMMIT

o Generate a Personal Access Token
4. After clicking “Generate token”, your personal access token will be created, and you should see a 
confirmation screen like this:

Token added to PATs (Personal 
access tokens) list

Copy this token—we will use it in 
later steps as well. Please keep this 
tab open until the setup is 
complete, as this token will not be 
shown again.
Note: This token is like a key to 
your GitLab home, so do not share 
it publicly. Once you have 
completed the next slides setup 
steps, you can remove it from 
wherever you temporarily copied 
it.
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GITLAB – PUSHING FIRST COMMIT

o Enable credential storage
o Run this command so Git stores your login 

credentials locally:
o git config --global credential.helper store

o Push your code
o git push --set-upstream origin main
o Authenticate when prompted

o Username: your JLab username
o Password: paste the Personal Access 

Token you just generated

o Verify remote
o Get your remote repository URL:

o git remote -v
o You can Ctrl/Cmd + click the URL to open it in 

your browser and confirm your first commit 
has been successfully pushed.
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GITLAB – GIT CHEAT SHEET

o Refer to the Git cheat sheet and explore additional commands:
o https://git-scm.com/cheat-sheet

o Some commonly used commands:
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WHAT’S COMING NEXT?
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o Learn how to use AI agents in VS Code to code—turning ideas into working apps is now 
faster than ever. 

https://indico.jlab.org/event/1069/timetable/#20260515 

o See what others are building with 
AI—and build your own too.

o Join us on May 15 for New LLM 
Updates at JLab and turn ideas into 
working products.

https://indico.jlab.org/event/1069/timetable/#20260515

	Slide 1
	Slide 2: jlab account: what do you get access to?
	Slide 3: what setup is required other than jlab account?
	Slide 4: jlab web portal
	Slide 5: jlab web portal
	Slide 6: office 365/ outlook (only for staff or interns)
	Slide 7: Virtual private network (VPN)
	Slide 8: Gitlab (code.jlab.org)
	Slide 9: JupyterHub
	Slide 10: Virtual desktop infrastructure (VDI)
	Slide 11: Jlab filesystems
	Slide 12: Jlab filesystems – disk usage
	Slide 13: JLab filesystems – how to access
	Slide 14: JLab ifarm
	Slide 15: JLab ifarm
	Slide 16: Jlab ifarm - accessing via vscode (remote ssh)
	Slide 17: Jlab ifarm - accessing via vscode (remote ssh)
	Slide 18: Hands-On Session
	Slide 19: Outline
	Slide 20: section 1: vscode setup & basics
	Slide 21: Installing Vscode
	Slide 22: Vscode – Opening your first folder
	Slide 23: Vscode – Opening your first folder
	Slide 24: Vscode – Opening your first folder
	Slide 25: Vscode – Opening your first folder
	Slide 26: Vscode – Opening your first folder
	Slide 27: Vscode – Explorer View
	Slide 28: Vscode – Activity Bar
	Slide 29: Vscode – Activity Bar
	Slide 30: Vscode – View and Edit Files
	Slide 31: Vscode – View and Edit Files
	Slide 32: Vscode – View and Edit Files
	Slide 33: Vscode – View and Edit Files
	Slide 34: Vscode – Open Terminal
	Slide 35: Vscode – Run a command in Terminal
	Slide 36: Vscode – Multiple Terminals
	Slide 37: Vscode – Keyboard shortcuts
	Slide 38: Vscode – Keyboard shortcuts
	Slide 39: section 2: Remote ssh to ifarm
	Slide 40: Vscode – Remote ssh to ifarm
	Slide 41: Vscode - installing remote ssh extensions
	Slide 42: Vscode - installing remote ssh extensions
	Slide 43: Vscode – setting up ssh config file
	Slide 44: Vscode – setting up ssh config file
	Slide 45: Vscode – setting up ssh config file
	Slide 46: Vscode – ssh config file explanation
	Slide 47: Vscode - Connect to ifarm
	Slide 48: Vscode - Connect to ifarm
	Slide 49: Vscode - Connect to ifarm
	Slide 50: Vscode - Connect to ifarm
	Slide 51: Vscode – Open a folder on ifarm
	Slide 52: Vscode – Open a folder on ifarm
	Slide 53: section 3: Filesystems Disk capacity
	Slide 54: ifarm – checking filesystems disk capacity
	Slide 55: ifarm – checking filesystems disk capacity
	Slide 56: ifarm – checking filesystems disk capacity
	Slide 57: ifarm – filesystems disk capacity & vscode
	Slide 58: ifarm – filesystems disk capacity & vscode
	Slide 59: ifarm – filesystems disk capacity & vscode
	Slide 60: ifarm – filesystems disk capacity & vscode
	Slide 61: ifarm – filesystems disk capacity & vscode
	Slide 62: section 4: Port Forwarding
	Slide 63: Port Forwarding
	Slide 64: Port Forwarding
	Slide 65: running network based apps on ifarm
	Slide 66: Vscode – port forwarding (example)
	Slide 67: Vscode – Port Forwarding
	Slide 68: section 5: X11 Forwarding
	Slide 69: X11 forwarding
	Slide 70: X11 forwarding – Using VDI
	Slide 71: X11 forwarding – Using VDI
	Slide 72: X11 forwarding – Using VDI
	Slide 73: X11 forwarding – Using VDI
	Slide 74: X11 forwarding – By SSH’ing to ifarm
	Slide 75: X11 forwarding – By SSH’ing to ifarm
	Slide 76: X11 forwarding – By SSH’ing to ifarm
	Slide 77: X11 forwarding – By SSH’ing to ifarm
	Slide 78: section 6: Gitlab first commit & push
	Slide 79: Gitlab - (code.jlab.org)
	Slide 80: Gitlab - (code.jlab.org)
	Slide 81: Gitlab – Creating a new repo
	Slide 82: Gitlab – Creating a new repo
	Slide 83: Gitlab – Creating a new repo
	Slide 84: Gitlab – Creating a new repo
	Slide 85: Gitlab – Creating a new repo
	Slide 86: Gitlab – Creating a new repo
	Slide 87: Gitlab – Creating a new repo
	Slide 88: Gitlab – Creating a new repo
	Slide 89: Gitlab – Your first commit
	Slide 90: Gitlab – Pushing first commit
	Slide 91: Gitlab – Pushing first commit
	Slide 92: Gitlab – Pushing first commit
	Slide 93: Gitlab – Pushing first commit
	Slide 94: Gitlab – Pushing first commit
	Slide 95: Gitlab – Git cheat sheet
	Slide 96: What’s coming next?

